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Overview
Read&Write software is available to all students, staff and faculty at Aims and can be used to:

Hear digital text read aloud — great for proofreading papers

Dictate a paper with speech-to-text technology

Convert documents into mp3 files

Soften screen glare and reduce visual stress with screen masking

Convert paper documents and image-based PDFs into text-based digital documents

Click here to download a Quick Reference Guide with all tools listed.

Click on the video thumbnail below to open an overview of features on YouTube.
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Walch on  [EBYouTube

Access

The license that Aims has purchased allows for users to install it on personal devices at
home. The download link for installation on home devices is located on this webpage.

NOTE: The latest version is installed on all student-use computers. Employees are welcome
to put in a help desk request if they wish to have it installed on their work computers.



https://texthelp-website-proof.cdn.prismic.io/texthelp-website-proof/0b20d4ac-b9b4-45c4-bdd9-56e18935d842_Read%26Write+for+Google+Chrome+-+Quick+Reference+Guide+04_2022.pdf
https://www.youtube.com/watch?v=YJ5N1BQc0bc
https://www.texthelp.com/en-us/products/read-write/
https://www.aims.edu/resource-library/web-help-desk-ticket

Get Help

If you need assistance with installation on a personal device or have questions about how to
use Read&Write, feel free to contact the Learning Resource Technicians in the Learning
Commons at 970-339-6506, LC.Tech@aims.edu, or fill out a general support request here.
Install Guide Personal Devices

Click on the links or video thumbnails below to open and view the video guides on
YouTube and learn how to download and use Read&Write on your device.

Read&Write for Mac

o Read&Write for Google Chrome: Student Take-... D
w ERBAR

-m read&write
>

Student Take Home Install Guide

©

Watch on 3 YouTube

Read&Write for Mac Quick Reference Guide PDF
1. Download Read&Write for Mac.

2. Run ReadWriteGold.pkg from the Downloads folder. You may be presented with a dialog
stating that ReadWriteGold.pkg can’t be opened because it is from an unidentified
developer. Click OK.

“ReadWriteGold.pkg” can't be opened

: because it is from an unidentified
(9{ developer.

Your security preferences allow installation of only
apps from the Mac App Store and identified
developers.

Safari downloaded this file today at 4:07 PM from

wwwiest.aims.edu

? ———

o
3. Open System Preferences ﬁ and click on Security & Privacy %= and click Open
Anyway.


mailto:LC.Tech@aims.edu
https://aims.formstack.com/forms/general_computer_support
https://www.youtube.com/watch?v=iJo1IblwF9o&list=PLvSZbmGbKpCSms6EDxSVm7oaysekYLIPZ
https://www.youtube.com/watch?v=iJo1IblwF9o&list=PLvSZbmGbKpCSms6EDxSVm7oaysekYLIPZ

L { = Security & Privacy qQ

FileVault  Firewall  Privacy |

Alogin password has been set for this user | Change Password... |
Require password _immediately [ after sleep or screen saver begins

=D

Allow apps downloaded from:
* Ma
*“ReadWriteGold pkg" was blocked from cpening Open Anyway

because it is not from an identified developer.

] Glick the lock to make changes.

You may be prompted for your username and password.

4. On the Install ReadWriteGold dialog, click Continue twice and then click Install.
@ @ Install ReadWriteGold |
Welcome to the ReadWriteGold Installer

@ Introduction

Destination Select

You will be guided through the steps necessary to install this
software.

Installation Type

Installation
Summary
Continue
-
Standard Install on “Untitled"
e This will take 1.24 GB of space on your computer.
» Destination Select Click Install to perform a standard installation of this software

on the disk “Untitled”.
» Installation Type

Installation

Summary

Change Install Location...

Go Back Install



o w» Install ReadWriteGold

Select a Destination

Select the disk where you want to install the

Int ion
Ao ReadWriteGold software.
» Destination Select

nstallation Type q ' .

nstallation “

Summary

Untitled
979.56 GB available
999,35 GB total

Installing this software requires 1.24 GB of space.
You have chesen to install this software on the disk “Untitled”.

Go Back Continua

You may be prompted for your username and password.

5. When the install is complete, click Close.

[ ] w Install ReadWriteGold
The installation was leted sL
* Introduction
@ Destination Select
» Installation Type
» Installation
® Summary The installation was successful.

The software was installed.

6. Click on the Launchpad icon ‘ and click on the Read&Write Gold icon.
You may be prompted for your username and password. If the program launches but does
not present a License Agreement window, close and restart Read&Write Gold and click
Cancel when prompted for username and password.

7. Accept the license agreement and choose OK.

A cense reamen

You must agree with the license agreement to proceed.

Click here to view license agreement

| accept the license agreement
T ; o e

| do not accept the license agreement




8. Click on Activate.

Read&Write Home User Mac Activation

Please enter your serial number below Read A

Serial Number L
i | &Write
Activation Code Gold

Activate by telephone Activate Skip Activation

9. After the program activates, the following prompt will appear. Choose “Don’t Ask”. This

installation already includes many high-quality voices.
1

High Quality Voices Available
There are high quality voices available for download on

the Read&Write Essentials website. Would you like to
download them now?

Some tools in the Read&Write toolbar require the Safari toolbar extension. A window will
prompt you to install the extension the first time you use one of these tools.

Read&Write for Google Chrome™

o Read&Write for Mac: Student Take-Home Inst... . D
o (SRR

-ﬂ read&write
>

Student Take Home Install Guide

«

Watch on (B8 YouTube



https://www.youtube.com/watch?v=w7h_J8fYXNc&list=PLvSZbmGbKpCTkk3S93CXtQWNf50f_Ow3D
https://www.youtube.com/watch?v=w7h_J8fYXNc&list=PLvSZbmGbKpCTkk3S93CXtQWNf50f_Ow3D

Read&Write's free extension can be installed from the Chrome Web Store. Follow the
steps below to install the Read&Write Chrome extension:

1. Open Google Chrome and navigate to the Chrome Web Store.

2. Enter "read and write" in the search box in the top left corner of the page.

£~ chrome web store

read&write X

readé&write

I read&write for google

5 misnsa

2. Locate "Read&Write for Google Chrome” under extensions.

Home > Extensions > Read&Write for Google Chrome™

.m Read&Write for Google Chrome™

{7} texthelp.com (8 Featured

Y Y W ok 2028 | Accessibility | 10,000,000+ users

3. Select the Add to Chrome button.

_m Read&Write for Google Chrome™
{7} texthelp.com (5 Featured
read&wrlte Boost reading and writing confidence across all types of content and devices, in class, at work, anc

for Google Chrome™
v W W W K& 2.028 Accessibility

4. Select the Add extension button in the pop-up window near the Chrome address bar.

m Add "Read&Write for Google Chrome™"?

It can:
Read and change all your data on all websites
Know your email address

Manage your apps, extensions, and themes

Cancel Add extension



https://chrome.google.com/webstore/category/extensions

5. Click on the Read&Write icon (a purple puzzle piece.m) in the top right corner of
Chrome.

6. After being prompted to sign in to your Google account, select the Allow button.

Read&Write for Windows

o Read&Write for Windows: Student Take-Home... J—D
Copy link
W texthelp

-m read&write
| 2

Student Take nome Install Guide

Watch on (28 Youlube

1. If the Read&Write Home setup installation files are in a folder that has a picture of a zipper on
them, the contents of the folder need to be extracted before they can be used.

onCode

Extract All...
Pin to Start

) Scanfor threats...
Open with...

Share with


https://www.youtube.com/watch?v=d7zG4apNHq8&list=PLvSZbmGbKpCQEi1OB-nu-wA5KexHppO9C
https://www.youtube.com/watch?v=d7zG4apNHq8&list=PLvSZbmGbKpCQEi1OB-nu-wA5KexHppO9C

3. Choose where you want to save the extracted files and click the “extract” button.
e e

Select a Destination and Extract Files

Files will be extracted to this folder:

[S b " Browse...

[7] Show extracted files when complete

[ Concel |

4. The unzipped folder should now look like this:

5. Within the folder there are three files:

I = | Application Tools ReadAndWriteHomeSetup - olEN
Share Wiew Manage ) a‘
T . ¢+ ReadAndWriteHomeSetup w | & search ReadAndWrteHomes... 0
¢ Favorites Mame Date modified Type Saze
B Desktop | Activation Code 9/15/2015 %31 AM Text Dacument 1KB
# Downloads -ﬁ Setup 9152015 %31 AM  Application 132 KB
l_'. Recent places 3 | Setup File version: 11.5.0.0 Configuration sett... 2KB

Date ereated: 11/18/2014 345 AM |

6. Double click on the setup file that has the puzzle piece. The installation will begin.

Read And Write 11

] Flease wait while Windows corfigures Read And Write 11
s

Time remaining: 52 seconds

|




7. The installation takes 5-15 minutes. Sometimes the window stalls on 0 seconds for several
minutes.

Read And Write 11

iﬂl Please wait while Windows configures Read And Wite 11

Time remaining: 0 seconds

[ |

8. There is no confirmation message that appears to inform you that the installation is complete.
Instead, you should see this icon on your desktop.

o

EeEse BN rte

1

9. Open the Read&Write software by double clicking on the puzzle piece icon. The Read&Write
Activation window displays. Click on the Activate Window. When the activation is successful, click
the “OK” button.

Read&Write Activation
read&write
Activation was successiul

10. The “Home User Access Code Login” Window will pop up. An access code is required to
continue.

Home User Access Code Login n
Flease enter your Access Code below:

Access Code

Login Bt



11. Your personal Activation Code is located within a text file. Go back to the installation files that
you unzipped and double click on the “Activation Code” text file.

ReadAndWriteHomeSetup - olEN
1 & » ReadAndWriteHomeSetup v G Search ReadAndWriteHome5... 0

oY Favorites fal MNarne : Date modified Type Size

[ Desktop | | Activation Code 915/2015%31 AM  Text Document 1 KB

& Downloads 4 Setup 91 :31AM  Application 138 KB

% Recent places | Setup 1 M  Cenfiguration sett... 2KB
& This PC -
Jitems 1 item selected 17 bytes E =

12. Your code will look something like this.
3 Activation Code - Notepad - ©
File Edit Format View Help
M3127-6BE36-94853 )
L

13. Enter your code in the “Home User Access Code Login” window and click login.
Home User Access Code Login ﬂ

Flease enter your Access Code below:

Access Code _
|M3127-6BE36-34853

Login

)

14. If the code was properly entered, you should see this window. Click the “OK” button.

Home User Access Login

read wlrite

Home User Access login was successful.



15. The Read&Write toolbar will automatically open.

Read8Write for Windows (Gold Edition) ﬂ

v - §F-m-2-9-V>r-l1 R

Differences Between Browsers

If you have more than one web browser installed, some Read&Write tools that you click on
will automatically open in your default browser.
e Internet Explorer and Safari do not require any extra plugins or extensions.
e Chrome requires an extension. Read&Write will prompt you to install the extension.
e Firefox requires a plugin. Read&Write will prompt you to install the plugin.



Videos: Read&Write Toolbar Training

Click here to access the full folder of training videos for each of the tools described below.

G Check It

The Check It tool is like the built-in Google Doc Suggestion tool.
The Google Suggestion tool seems to be more accurate.

i' Prediction

Write a sample here - | am
This is a practice tool to help students learn how to predict what's next

|_!!| Dictionary

Look up definitions within a document or website.
Listen to the pronunciation.

M
"

Picture Dictionary

Look up visual representation icons within a document or website.
Listen to the pronunciation.

’ II . Screen Reader

Select text to be read, then click the play, pause, or stop button.


https://drive.google.com/drive/folders/1kc-p3R-ojKCfZPzhPtEG4NeTEJ78xKe-?usp=sharing

o

Works on websites, not Google Apps. Like the Screen Reader, but only requires hovering to
trigger screen reading.

Hover Speech

LW Screenshot Reader

The box below is an image. You can use the Screenshot reader to OCR scan, read, and copy
text within an image.

X X X x — ===
Click and drag the magnets onto the Fridge to write your own
Y Y Y Y expressions or equations. + + +
0 0 00 f— S —
1 1 1 1 R R E
3333 SR
4 < < < <
4 4 4
BEEEas
J 1 1] = SRR
A A A~ ’ / i

@ Audio Maker

Select text to be read, then click to create an mp3 file. These files are downloaded and may
be shared with students.

P‘B Web Search

Select a word or phrase, and click the Web Search tool. Another tab will open containing
your Google search.


https://www.smore.com/91m4v-voice-typing-in-google-docs

[E Screen Mask

This tool helps to reduce distractions. Students should adjust settings to optimize the
screen mask experience. Click the tool to close.

0 Talk & Type

This turns on speech-to-text. It also works with voice commands. This is the same as the
Google Doc Voice Typing tool but works on most websites.

-y
",": Translator

Translate a selected word and listen to the word in both languages. Languages can be

Q Options

changed in the Options menu. >Speech >Translation

¥ L L LR Highlight tools

Provides quick access to 4 highlight colors. Works in conjunction with Collect Highlights &
Vocabulary tools.

©* Collect Highlights

Click to create a ‘highlights’ Google Doc based on text you have highlighted. The Google Doc
is created in your My Drive folder and can be moved and shared.


https://www.smore.com/91m4v-voice-typing-in-google-docs

== Vocabulary

Click to create a ‘vocabulary’ Google Doc based on text you have highlighted. The Google
Doc is created in your My Drive folder and can be moved and shared.

“ Voice Note

Record a voice note that will be inserted into the document as a comment.

=4 Simplify Page

Remove distractions & simplify the page formatting & content. Works on websites, not
Google Apps.

% practice Reading Aloud

Students record themselves reading aloud and submit the recording to the teacher. On a
Google Doc, a student must select text, then click the Practice Read Aloud button. On a
website, a student must only click the Practice Read Aloud button.

Troubleshooting

c If the Read & Write toolbar is not functioning properly, reload the Chrome browser.

i

If the Read & Write toolbar does not appear in your Chrome browser, check that you
are signed in to the Chrome browser with your City Schools Google credentials and that you
are syncing.


https://www.washingtonpost.com/

E PDF Reader

*Click to open, then make a copy of the PDF Reader Interactive Guide

SMI D) IIEBNRLET £ 01

mple PDE
PDF text-to-speech functionality requires that you open PDFs using the separate
Texthelp PDF Reader Chrome extension.

e If a teacher or student opens a Google Classroom assigned PDF copy, PDF Reader
launches automatically (if signed into City Schools Chrome on a computer).
e If you open a PDF from Google Drive, click the ‘Open with’ menu at the top center.

Choose ] Readsirite for Google Chrome™ o Jaunch [ Texthelp PDF Reader.
o PDF annotation only works from ‘My Drive, not ‘Shared Drives’
e If you open a PDF from a website URL/link, click the ‘PDF’ button on the top left.

Y
Eﬁ Open with Texthelp PDF Reader

o T A € 14 ppF annotation tools are included.
# Save to Google Drive required for saved annotation from a web PDF.


https://drive.google.com/file/d/1dBVoNktT8W8d_y2NbXnDnRtG9Ra5iBhX/view?usp=sharing
https://www.k12blueprint.com/sites/default/files/Personalized-Learning-Guidebook.pdf

